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1
Introducing WebEx Integration 
to Outlook

About WebEx Integration to Outlook
WebEx Integration to Outlook provides a convenient way for you to schedule or 
start online meetings or Audio Only meetings using Microsoft Outlook. Using 
Integration to Outlook, you can perform these activities without the need to use 
your WebEx service Web site—that is, the site on which you normally schedule and 
join your online meetings.

WebEx Integration to Outlook is an add-in program for Microsoft Outlook. You 
download Integration to Outlook from your WebEx service Web site, and then 
install it on your computer. Once you install Integration to Outlook, WebEx 
options appear in Microsoft Outlook, allowing you to quickly schedule an online 
meeting.

If you want to... See...

get an overview of WebEx Integration to 
Outlook

About WebEx Integration to Outlook on 
page 1

get an overview of each Integration to Outlook 
option

About the Integration to Outlook options on 
page 3

check for version updates Checking for updates to Integration to Outlook 
on page 5

uninstall WebEx Integration to Outlook Uninstalling WebEx Integration to Outlook on 
page 5
1



Chapter 1: Introducing WebEx Integration to Outlook
Note

Before you use WebEx Integration to Outlook, ensure that:

■ You have a user account on your WebEx service Web site.

■ The Integration to Outlook option is available on your WebEx service Web site.

■ Your computer is connected to the Internet.

■ You are familiar with Microsoft Outlook.

When scheduling a meeting, you can invite attendees using any of your Outlook 
address lists, including the Global Address List, Personal Address List, or Contacts 
folder. Attendees whom you invite to a meeting do not need to use Integration to 
Outlook to join the meeting.

To provide security for your meetings, Integration to Outlook uses 128-bit SSL 
(Secure Sockets Layer) encryption for all data it sends to and retrieves from your 
WebEx service Web site.

WebEx Integration to Outlook also provides the following:

■ quick access to My WebEx on your WebEx service Web site, which includes your 
personal list of meetings, user profile, and other account options

■ quick access to the One-Click Setup page on your WebEx service Web site, on 
which you can set up an instant meeting that you can start at any time, as often 
as you want (not available for all WebEx service sites)

■ a template for meeting invitations, which you can modify with any information 
you want

System requirements

Before installing WebEx Integration to Outlook, ensure that your computer meets 
the following system requirements:

■ Windows 2000, XP, or Vista or Windows Server 2003

■ Intel x86 (Pentium 400MHZ +) or compatible processor 

■ Microsoft Internet Explorer 6 or later, Netscape Navigator 7.x or later, Mozilla 
1.6 or later, or Firefox 1.x or later

■ JavaScript and cookies enabled for the browser 

■ 56K or faster Internet connection 

■ Microsoft Outlook 2000 or later
2



Chapter 1: Introducing WebEx Integration to Outlook
Installing WebEx Integration to Outlook

You can download WebEx Integration to Outlook from your WebEx service Web 
site. 

Note To download WebEx Integration to Outlook, you must have a host account 
on your WebEx service Web site.

To download WebEx Integration to Outlook from your WebEx service site:

1 Log in to your WebEx service site.

2 On the left navigation bar of your WebEx service site, click Support > 
Downloads.

3 Go to the Integration to Outlook 3.2. section, and then click Download now.

4 Save the installation file, which has a .msi extension, to your local computer.

5 Run the installation file.

6 Follow the instructions in the wizard to complete the installation.

About the Integration to Outlook options
After you install WebEx Integration to Outlook, the WebEx toolbar appears in the 
Microsoft Outlook window, as follows:

Click and drag one of these lines to 
“float out” the WebEx toolbar, as you 
can with the Microsoft Outlook toolbars.

Clicking the X button closes the floating 
toolbar. To regain the toolbar, right-click 
any Microsoft Outlook toolbar, and then 
choose WebEx Integration.
3



Chapter 1: Introducing WebEx Integration to Outlook
The following table describes the WebEx toolbar buttons.

Button Description

WebEx Clicking this button opens a menu that provides the following 
options:

■ My WebEx—Lets you access My WebEx, in which you can 
manage your account information and the meetings that you 
scheduled, on your WebEx service Web site. For details about 
My WebEx, refer to the online Help on your site.

■ Account Settings—Lets you specify your WebEx user account 
information—that is, the URL of your WebEx service Web site 
and your user name and password. 

■ Meeting Templates—Lets you view templates that you or your 
site administrator saved on your WebEx service Web site. The 
templates contain meeting settings. You can select the template 
that meets your needs.

■ Invitation Template—Lets you open the template for meeting 
invitations and customize the template for your needs. For 
details, see About customizing meeting invitation templates on 
page 27.

■ Set Scheduling Permission—Opens the My WebEx Profile 
page on which you can assign a delegate to schedule or edit 
meetings on your behalf. For details, see Assigning a delegate 
to schedule meetings for you on page 19.

■ Check for Update—Lets you check for updates to WebEx 
Integration to Outlook.

■ Help—Lets you look up instructions for using WebEx 
Integration to Outlook.

■ About—Lets you view the version number and licence and 
patent information about WebEx Integration to Outlook.

Schedule Meeting Clicking this button opens the Outlook Appointment window, which 
now contains Integration to Outlook options for scheduling an 
online or Audio Only meeting.

Note The Meeting window in Outlook also contains the WebEx 
integration options. 

One-Click Meeting If you have not yet set up a One-Click Meeting, clicking this button 
opens the One-Click Setup page on your WebEx service Web site, 
on which you can set up a One-Click Meeting. If you have already 
set up a One-Click Meeting, clicking this button starts the meeting. 

A One-Click Meeting is an instant meeting that you can start at any 
time, without having to schedule the meeting. For details, refer to 
the user’s guide on your WebEx service Web site.
4
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Checking for updates to Integration to Outlook

You can periodically check for updates to WebEx Integration to Outlook. If an 

update is available, Integration to Outlook also asks you whether you want to install 
the update.

To check for updates to Integration to Outlook:

1 Start Microsoft Outlook if it is not already open.

2 On the Outlook toolbar, click WebEx, and then choose Check for Update.

Uninstalling WebEx Integration to Outlook
At any time, you can uninstall the WebEx Integration to Outlook add-in from your 
computer.

To uninstall Integration to Outlook:

1 Exit Microsoft Outlook. 

2 Ensure that no Outlook processes are still running on your computer, by doing 
either of the following:

■ Reboot your computer. 

■ Terminate any running Outlook processes, as follows:

Press Ctrl+Alt+Delete on your computer’s keyboard. 

Click Task Manager.

Click the Processes tab.

Select the OUTLOOK.EXE process.

Click End Process.

3 Do either of the following:

■ Open the Windows Add/Remove Programs utility on your computer, select 
WebEx Integration to Outlook, and then select the option to remove the 
program.

■ Double-click the Integration to Outlook Setup program (olkInt.msi), and 
then follow the instructions to remove the program.
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2
Scheduling a Meeting

About scheduling a meeting
To schedule an online meeting using WebEx Integration to Outlook and to send 
meeting invitations, be aware of the following :

■ You must verify your WebEx account information. For details, see Specifying 
your account information on page 8.

■ Integration to Outlook provides basic options for scheduling a meeting. Some 
options that appear on your WebEx service Web site are not available in 
Integration to Outlook. 

■ Integration to Outlook does not support all of the recurrence options that are 
available in Microsoft Outlook. For details, see Specifying a recurrence pattern for 
a meeting on page 18.

■ In any meeting invitations that you send from Microsoft Outlook, the meeting’s 
starting time appears in the time zone that is set on your computer, not in your 
site preferences for your WebEx service.

On your WebEx service Web site, all meeting times appear in the time zone that 
you set in your site preferences, regardless of the time zone that is set on your 
computer.

If you want to... See...

get an overview of scheduling a meeting using 
Integration to Outlook

About scheduling a meeting on page 7

specify your WebEx account information Specifying your account information on 
page 8

set up a meeting and invite attendees to the 
scheduled meeting

Setting up a meeting and inviting attendees on 
page 8

assign a delegate to schedule or edit meetings 
for you

Assigning a delegate to schedule meetings for 
you on page 19
7



Chapter 2: Scheduling a Meeting
Specifying your account information
To set up an online meeting in Microsoft Outlook, you must specify your WebEx 
account information first.

To specify your WebEx account information:

1 In Microsoft Outlook, on the WebEx toolbar, click WebEx.

2 On the menu that appears, choose Account Settings.

The WebEx Account Settings dialog box appears.

3 In the WebEx site address text box, type the URL for your WebEx service Web 
site.

4 In the User name text box, type your user name for your meeting service.

5 In the Password text box, type your password.

6 Optional. To let Outlook log you in to your WebEx service automatically when 
you schedule a meeting or access the My WebEx area on your WebEx service site, 
select Remember my user name and password.

7 Click OK to save your account settings.

Setting up a meeting and inviting attendees

If you want to... See...

set up a meeting using Integration to Outlook Setting up a meeting on page 9

invite attendees to a scheduled meeting Inviting attendees on page 11

learn what each WebEx option does About the WebEx Settings dialog box on 
page 12

specify a recurring meeting Specifying a recurrence pattern for a meeting 
on page 18
8



Chapter 2: Scheduling a Meeting
Setting up a meeting

To set up an online meeting using WebEx Integration to Outlook, open a new 
Meeting Request or Appointment window in Outlook, and then specify 
information and settings for the meeting.

To set up a meeting using Integration to Outlook:

1 Do either of the following in Microsoft Outlook:

■ Click Schedule Meeting on the WebEx toolbar.

■ On the File menu, choose New > Meeting Request or Appointment.

A scheduling window appears with the Add WebEx Meeting button.

2 Do the following to specify general meeting information:

■ Type a topic for the meeting in the Subject box.

■ In the Start time and End time drop-down lists, specify the starting and 
ending times for the meeting, respectively.
9



Chapter 2: Scheduling a Meeting
■ Optional. To specify a recurrence pattern for your meeting, click Recurrence, 
and then select recurrence options. For details, see Specifying a recurrence 
pattern for a meeting on page 18.

■ Optional. Specify other options that Microsoft Outlook provides, such as a 
meeting reminder. 

3 Click Add WebEx Meeting to specify meeting settings.

4 If the WebEx Account Settings dialog box appears, type the necessary 
information, and then click OK. 

The WebEx Settings dialog box appears. If you are scheduling the meeting for 
another host, a message, “You’re scheduling for [host name],” indicates that in 
the WebEx Settings dialog box.

5 Specify WebEx meeting settings, and then click OK.

For details, see About the WebEx Settings dialog box on page 12.

6 Do one of the following, as appropriate:
10



Chapter 2: Scheduling a Meeting
■ Send meeting invitation to attendees. For details, see Inviting attendees on 
page 11.

■ Click Save and Close, and invite attendees to the scheduled meeting at a later 
time.

Integration to Outlook contacts your WebEx service Web site, and then adds the 
scheduled meeting to:

■ your Outlook calendar 

■ the list of meetings on the My WebEx Meetings page on your WebEx service 
Web site

■ your Personal Meeting Room page, if your account includes one

Inviting attendees

When using WebEx Integration to Outlook to schedule a meeting, you can invite 
attendees by selecting their names or email addresses in any of your Microsoft 
Outlook contacts lists. For example, if your organization maintains a Global 
Address List, you can invite attendees by selecting their names in that list. You can 
also invite attendees who are not in an Outlook contacts list by entering their email 
addresses.

Once you invite an attendee to a scheduled meeting, he or she receives an invitation 
email message. The email message includes information about the meeting—
including its password—and a link that the attendee can click to join the meeting.

You can customize the meeting invitation templates. For details, see About 
customizing meeting invitation templates on page 27.

To send meeting invitation:

1 If you have scheduled a meeting using WebEx Integration to Outlook, open the 
meeting item in your Outlook calendar.

If you opened an Appointment window, click Invite Attendees to see the To box. 
The following figures show an example.
11



Chapter 2: Scheduling a Meeting
2 Enter attendees’ names or email addresses in the To box, and then click Send.

Note Any attendees that you invite using WebEx Integration to Outlook do not 
appear in the attendees list for the meeting on your WebEx service Web site.

About the WebEx Settings dialog box

How to access the WebEx Settings dialog box: 

In an open Meeting or Appointment window, click Add WebEx Meeting or Change 
Settings, as appropriate.

What you can do in the WebEx Settings dialog box:

Set options for your online meeting. 

The following tables describe what you can do with each option.

After you click Invite Attendees, the To box 
appears, in which you can enter attendees’ 
names or email addresses.

To remove the To box, in which you can enter 
attendees’ names or email addresses and 
invite them, click Cancel Invitation.
12



Chapter 2: Scheduling a Meeting
Basic settings:

Template and Password

Use this option ... To ...

Meeting template Select a template that contains the meeting settings that you 
or your site administrator saved on your WebEx service site. 
Once you select a template, WebEx Integration to Outlook 
automatically selects the settings or options in the dialog box. 
You can change the settings later if necessary.

To view the content of a template, click . 

Note If this drop-down list displays only service types, your 
WebEx service site may not have been updated for the latest 
service version. Please contact your account manager for 
more information.

Meeting password Specify a password that attendees use to join the meeting.

Note Your site administrator may require that all passwords 
comply with security criteria, such as a minimum length and a 
minimum number of letters, numbers, or special characters. 
Contact your site administrator for details.

Confirm password Confirm the password you typed.

Exclude password from 
email invitation

Specify that the invitation email message that Integration to 
Outlook sends to invited attendees does not contain the 
meeting password. 

If you select this option, you need to notify attendees of the 
password, if there is one, by other methods, such as by phone 
or instant messaging.

Note If you require registration, this option is automatically 
selected. After you approve an attendee’s registration 
request, the attendee receives another automatic email 
message that includes the password. For more information, 
see Attendee Information on page 15.

Do not list this meeting on 
WebEx site 

Specify that the meeting does not appear on the calendar on 
your WebEx service Web site. Attendees must provide the 
meeting number to join the meeting.
13



Chapter 2: Scheduling a Meeting
General Settings tab:

Audio Conference

Use this option ... To ...

WebEx Teleconference Specify that the meeting includes an integrated WebEx 
teleconference. Instructions for joining a teleconference 
appear on participants’ screens once they join the meeting.

If you select this option, you can select one or both of the 
following:

■ Attendees receive call back: Meeting participants 
provide their phone numbers when they join the meeting 
and receive a call back. When the participant answers the 
call, a voice prompt instructs the participant about how to 
join the teleconference. The meeting host or the host's 
organization assumes the charges for participants' calls.

■ Integrated VoIP: Meeting participants use computers with 
audio capability to communicate over the Internet rather 
than the telephone system. 

The call-in option is always available for WebEx 
teleconference. When a participant calls the provided phone 
number, a voice response system guides the participant 
through the process of entering the meeting number and his 
or her caller ID to join the teleconference. If your site provides 
toll-free call-in teleconferencing, both a toll-free number and a 
toll number are available. The toll number allows participants 
who cannot use the toll-free number—such as participants in 
countries other than the U.S. or Canada—to join the 
teleconference.

If your site includes toll-free call-in teleconferencing, your 
organization assumes the charges for the calls. Otherwise, 
participants assume the charges for their calls.

If your site includes international local call-in numbers, you 
can select Allow access to teleconference via 
international local call-in numbers for attendees to join the 
meeting by dialing a local number.

Other Teleconference Specify that the meeting includes a teleconference that 
another service provides, such as a third-party 
teleconferencing service or internal teleconferencing system, 
such as a PBX (private branch exchange). If you select this 
option, type instructions for joining the teleconference in the 
box. The instructions will display in the following instances:

■ the invitation email message that you send using 
Integration to Outlook

■ a message box when an attendee joins the meeting.

You can also select Integrated VoIP, which allows meeting 
participants to use computers with audio capability to 
communicate over the Internet rather than the telephone 
system.
14



Chapter 2: Scheduling a Meeting
Tracking Code

Advanced Settings tab:

Attendee Information

Use VoIP Only Specify that the meeting includes only Integrated VoIP, which 
allows meeting participants to use computers with audio 
capability to communicate over the Internet rather than the 
telephone system. 

None Specify that the meeting does not include either 
teleconference or Integrated VoIP.

Use this option ... To ...

Tracking code Identify your department, project, or other information that 
your organization wants to associate with your meetings. 
Tracking codes can be optional or required, depending on 
how your site administrator set them up. 

If your site administrator requires you to enter a code from a 
predefined list, click Select Tracking Code, and then type a 
tracking code or select one from the drop-down list. 

Use this option ... To ...

Require attendee 
registration

Specify that all attendees must register to attend the meeting. 
An attendee cannot attend the meeting until you accept his or 
her registration request. 

You can require attendees to provide additional information 
when registering for a meeting, by editing the meeting on your 
WebEx service Web site and using the registration options 
available on your site. For details, see the online Help on your 
WebEx service Web site.

Not available for all WebEx service sites.

Note If you require registration, the Exclude password 
from email invitation check box in the WebEx Settings 
dialog box is automatically selected. After you approve an 
attendee’s registration request, the attendee receives another 
automatic email message that includes the password. For 
more information, see Template and Password on page 13.

Automatically accept all 
registration requests

Accept all registration requests automatically, and let all 
registrants attend the meeting. You do not receive registration 
requests. If this option is not selected, you must accept or 
reject each registration request individually, using the options 
on your WebEx service Web site. For details, see the online 
Help on your WebEx service Web site.

Not available for all WebEx service sites.

Use this option ... To ...
15



Chapter 2: Scheduling a Meeting
Meeting Options

Attendees can join meeting 
X minutes before starting 
time

Allow attendees to join the meeting earlier than the meeting's 
scheduled starting time. If you select this option, specify in the 
drop-down list how early they can join the meeting.

Available only if your site administrator has turned on this 
option for your WebEx service; not available for all WebEx 
service sites. 

Note If you select this option, you can automatically share a 
presentation document once a participant joins the meeting. 
This option is useful if you want to inform or entertain 
participants while they wait for you to start the meeting. For 
details, see Meeting Options on page 16.

Attendees can also join 
teleconference before 
starting time

Allow attendees to join an integrated WebEx teleconference 
earlier than the meeting's scheduled starting time.

Available only if you select Attendees can join meeting X 
minutes before starting time.

Use this option ... To ...

Info tab template Select a template for the Info tab, which appears in the 
content viewer during the meeting. The Info tab contains 
information about the meeting, including the host, 
teleconference phone numbers, and host key, if you are the 
host.

Not available for all WebEx service sites; not applicable to 
Audio Only meetings.

Use this option ... To ...
16
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Alternate host Designate one or more attendees as alternate hosts for the 
meeting. An alternate host can start the meeting and act as 
the host. Therefore, an alternate host must have a user 
account on your WebEx service Web site. If there are multiple 
alternate hosts for the meeting, the alternate host who starts 
the meeting first is the temporary host while the other 
alternate hosts can join the meeting only as attendees.

If you join the meeting after an alternate host has started it, 
you automatically assume the host role.

To view a list of attendees in this box, ensure that you entered 
their names or email addresses in the To box in the main 
Meeting or Appointment window.

To designate one or more attendees as alternate hosts, 
select the attendees in the list that appears in this box. To 
select multiple attendees, hold down your keyboard’s Ctrl 
key.

Automatically play 
presentation

Specify that a presentation or document that you select here 
is shared automatically for participants who join the meeting 
before you do. The presentation or document appears in each 
participant's content viewer once he or she joins the meeting. 
If the presentation has multiple slides or pages, they advance 
automatically every 20 seconds.

The file that you select must:

■ be in the WebEx Universal Communications Format 
(UCF). For information about creating UCF files, refer to 
the guide Getting Started with WebEx Universal 
Communications Toolkit, which is available on your 
WebEx service Web site.

■ reside in your personal folders, which reside in My Files in 
the My WebEx area of your WebEx service Web site. You 
can select a UCF file that is already in your folders, or you 
can upload a new file to your folders and then select it 
while scheduling a meeting. 

Clicking Upload opens the Add/Select Presentation page on 
your WebEx service Web site, on which you can select a 
presentation or document that already exists in your personal 
folders, or upload a new file to your folders and then select it. 
When you finish selecting a file, click Done to close the 
Add/Select Presentation page.

Use this option ... To ...

Click this button to refresh the list.
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Specifying a recurrence pattern for a meeting

Using Microsoft Outlook recurrence options, you can specify a recurrence pattern 
for your online meeting. For example, you can specify that a meeting recurs at 2 
p.m. every Wednesday until a specific date. WebEx Integration to Outlook 
schedules the meeting on each day that you specify in the recurrence pattern.

The recurrence options that you can use with WebEx Integration to Outlook are 
limited to the options that are available on your WebEx service Web site. 
Depending on your WebEx service, the use of a recurrence pattern may not be 
supported. To learn which recurrence patterns that Integration to Outlook does not 
support, see Recurrence patterns that Integration to Outlook does not support on 
page 18.

To specify a recurrence pattern for an online meeting:

1 In the Meeting or Appointment window for the meeting, click Recurrence.

2 Specify the options in the dialog box, and then click OK.

Recurrence patterns that Integration to Outlook does not support

The following are the recurrence options in Microsoft Outlook that Integration to 
Outlook does not support:

■ weekly—Every [X] week(s) on 
[Monday/Tuesday/Wednesday/Thursday/Friday/Saturday/Sunday]

For this option, the value of X must always be 1 to be scheduled correctly both 
in Microsoft Outlook and on your WebEx service Web site.

If you schedule a meeting that repeats every X week, where X is greater than 1, 
in Microsoft Outlook, the meeting will be scheduled as you specify in Outlook, 
but will appear as a weekly meeting on your WebEx service site. 

■ monthly—The [first/second/third/fourth/last] [day/weekday/weekend day] of 
every [X] month(s)

For this option, you can select only a specific day of the week, such as Monday, 
Tuesday, Wednesday, Thursday, Friday, or Saturday, not [day], [weekday], or 
[weekend day].

■ yearly—The [first/second/third/fourth/last] [day/weekday/weekend day] of 

Click Recurrence to set a recurrence 
pattern for your meeting.
18
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every 
[January/February/March/April/May/June/July/August/September/October/N
ovember/December]

For this option, you can select only a specific day of the week, such as Monday, 
Tuesday, Wednesday, Thursday, Friday, or Saturday, not [day], [weekday], or 
[weekend day].

For Audio Only meetings, all repeating meetings must end within one year. Also, 
Integration to Outlook does not support the following recurrence options:

■ weekly—Every [X] week(s) on 
[Monday/Tuesday/Wednesday/Thursday/Friday/Saturday/Sunday]

For this option, the value of X must always be 1—that is, the pattern must be 
every week.

■ monthly by day—Day [X] of every [X] month(s)

The value of X in every [X] month must always be 1—that is, the pattern must 
be every month.

■ monthly by day of the week—The [second/third/fourth/last] 
[day/weekday/weekend day] of every [X] month(s)

The value of X in every [X] month must always be 1—that is, the pattern must 
be the first [Monday/Monday/Tuesday/Wednesday/Thursday/ 
Friday/Saturday] of every month.

■ yearly

Note If you use Integration to Outlook to modify meeting settings for a recurring 
meeting, you must apply the changes to the entire series of the meeting. For 
example, if you apply the changes to just a single occurrence of the meeting, the 
changes will show only in Outlook, not on your WebEx service Web site.

Assigning a delegate to schedule meetings for you
WebEx Integration to Outlook allows you to assign a delegate to schedule or edit 
meetings on your behalf. 

For example, if you need to host WebEx meetings on a regular basis, you can give 
your assistant permission to schedule meetings for you.

After given permission, your delegate can schedule, edit, cancel, and start meetings 
for you.

To assign a delegate to schedule meetings for you, do both of the following:

■ On your WebEx service Web site, give the delegate scheduling permission. For 
19
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details, see Assigning a delegate on your WebEx service Web site on page 20.

■ In Microsoft Outlook, select the delegate and share your calendar with him or 
her. For details, see Assigning a delegate in Microsoft Outlook on page 21.

Important

■ A meeting that your delegate scheduled will appear in your calendar. If you want 
to edit it, you must have WebEx Integration to Outlook 3.1 or a later version 
installed on your computer.

■ At any time, you can remove scheduling permission from your delegate.

Assigning a delegate on your WebEx service Web site

To assign a delegate, you give him or her scheduling permission on the My WebEx 
Profile page on your WebEx service site. You can go to the page directly from 
Microsoft Outlook. 

If you want to go to the My WebEx Profile page without using Microsoft Outlook, 
you can log in to your WebEx service Web site, and then click My WebEx > My 
Profile.

Besides giving scheduling permission on your WebEx service Web site, you must 
also share your calendar with the delegate in Microsoft Outlook. For details, see 
Assigning a delegate in Microsoft Outlook on page 21.

Important

■ If you do not see the option to assign a delegate on your WebEx service Web site, 
ensure that your site administrator turns on the feature.

■ Your delegate must also have a WebEx host account on your WebEx service Web 
site. 

■ The email addresses for both your and the delegates’ accounts on your WebEx 
service Web site must match those in Microsoft Outlook.

To assign a delegate on your WebEx service Web site:

1 In Microsoft Outlook, click WebEx.

2 On the menu that appears, choose Set Scheduling Permission.
20
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The My WebEx Profile page appears.

3 Click Select From Host List.

4 In the Select Hosts window that appears, select the email address of the delegate, 
and then click Add > OK.

5 Click Update.

Assigning a delegate in Microsoft Outlook

To assign a delegate, you share your calendar with him or her in Microsoft Outlook. 

Besides sharing your calendar in Microsoft Outlook, you must also give scheduling 
permission on your WebEx service Web site. For details, see Assigning a delegate on 
your WebEx service Web site on page 20.

Important

■ Ensure that the calendar you share does not reside in your personal folder in 
Microsoft Outlook. Your delegate can access your calendar only if it resides in a 
public folder.

■ The name of the delegate you want to assign must be in the Global Address List 
in your Microsoft Outlook. 

To assign a delegate in Microsoft Outlook:

1 On the Tools menu, choose Options.
21
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2 On the Delegates tab, click Add.

3 Select the delegate’s name, and then click OK.

4 In the Delegate Permissions dialog box, select Editor in the Calendar drop-down 
list, and then click OK.

5 Click Apply > OK.
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Scheduling for Another Host

About scheduling a meeting for another host
Delegates only

You can schedule a meeting on behalf of another host if the host gave you the 
permission to do so. 

For example, if you are an administrative assistant to a director who needs to host 
WebEx meetings on a regular basis, the director can assign you to schedule 
meetings on his or her behalf.

With scheduling permission given by another host, you can schedule, edit, and 
cancel meetings for that host.

Before you schedule a meeting for another host, ensure that:

■ You have a WebEx host account. To obtain a WebEx host account, contact your 
site administrator.

■ The WebEx Integration to Outlook add-in program is installed in your 
Microsoft Outlook.

■ The actual host does the following:

■ gives you scheduling permission on the WebEx service Web site. For details, 
see Assigning a delegate on your WebEx service Web site on page 20.

If you want to... See...

get an overview of scheduling on behalf of 
another host

About scheduling a meeting for another host 
on page 23

schedule a meeting or an appointment for 
another host

Scheduling a meeting or an appointment for 
another host on page 24
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■ selects you as a delegate in Microsoft Outlook and shares his or her calendar 
with you. For details, see Assigning a delegate in Microsoft Outlook on page 21.

Note

■ After scheduling a meeting on behalf of another host, you can also start the 
meeting for that host, if necessary. For details, see Starting a meeting for another 
host on page 25.

■ At any time, the actual host can remove scheduling permission from you.

Scheduling a meeting or an appointment for 
another host

Delegates only

To schedule a meeting or an appointment for another host, first open the host’s 
Microsoft Outlook calendar, which the host already shared with you.

To schedule a meeting or an appointment for another host:

1 Open the other host’s calendar in Microsoft Outlook by doing the following:

a On the File menu, choose Open > Other User’s Folder.

The Open Other User’s Folder dialog box appears.

b Type the name of the actual host or click Name to select the actual host’s 
name.

c Select Calendar in the Folder type drop-down list, and then click OK.

The shared calendar appears. 

Note There are multiple ways of opening another person’s calendar, depending 
on how you customize your views in Microsoft Outlook. For details, see the 
Microsoft Outlook Help.
24
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2 If you are viewing multiple calendars side by side, ensure that you select the 
actual host’s calendar by clicking it once.

3 Open a new Meeting Request or Appointment window in Outlook, and then 
specify information and settings for the meeting. For details, see Setting up a 
meeting on page 9.

You can also edit or cancel the meeting you scheduled. For details, see Editing a 
scheduled meeting on page 33 and Canceling a meeting on page 34.

Starting a meeting for another host

Once you schedule a meeting for another host, the actual host receives a 
confirmation email message in his or her Microsoft Outlook. First ensure that the 
actual host still shares his or her calendar with you in Microsoft Outlook. Then you 
can start the meeting from the host’s calendar. 

To start a meeting for another host:

1 Open the other host’s calendar in Microsoft Outlook by doing the following:

a In Microsoft Outlook, on the File menu, choose Open > Other User’s Folder.

The Open Other User’s Folder dialog box appears.

b Type the name of the host or click Name to select the host’s name.

If you are scheduling the meeting for another host, a message 
indicates that in the WebEx Settings dialog box . 
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c Select Calendar in the Folder type drop-down list, and then click OK.

The shared calendar appears. 

Note There are multiple ways of opening another person’s calendar, depending 
on how you customize your views in Microsoft Outlook. For details, see the 
Microsoft Outlook Help.

2 Double-click the meeting item in the other host’s calendar.

The confirmation email message appears.

3 To start the meeting, follow the instructions in the email message, and ensure 
that you log in to your own WebEx host account on the WebEx service Web site.
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Customizing Meeting 
Invitation Templates

About customizing meeting invitation templates
Integration to Outlook provides a template for meeting invitations that you send to 
attendees. The information in the template appears in the text area of Microsoft 
Outlook invitation email messages.

The following figure shows an example.

If you want to... See...

get an overview of customizing meeting 
invitation templates

About customizing meeting invitation 
templates on page 27

customize meeting invitation templates Customizing your meeting invitation on 
page 30
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About variables in the invitation template

You can customize the invitation template by editing the default text or rearranging 
variables——codes that your WebEx service recognizes and substitutes with your 
specific meeting information. 

The following figure shows an example of the template. 

This area contains information from the 
invitation template.
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The default invitation template provides the following variables.

Variable Displays ...

<Host Name> your first and last names, as they appear in your user profile on 
your WebEx service Web site.

<Meeting Date> the date on which the meeting occurs, as it appears in the Start 
time box in your meeting invitation.

<Meeting Time> the time on which the meeting occurs, as it appears in the Start 
time box in your meeting invitation.

<Meeting Number> the unique number that your WebEx service assigns to a meeting. 
For an unlisted meeting, participants must provide the meeting 
number to attend the meeting.

<Meeting Password> the password for the meeting, as you specified it in the WebEx 
Settings dialog box when scheduling the meeting.
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Customizing your meeting invitation
If you customize the template, you can reset it to its default state at any time, 
regardless of whether you removed any variables.

To customize the meeting invitation template:

1 In Microsoft Outlook, on the toolbar, click WebEx, and then choose Invitation 
Template.

2 In the Invitation Template window, edit the message.

For details about editing the template, see About variables in the invitation 
template on page 28.

3 Click Update.

<TeleconferencingInfo> information about how to join a teleconference for the meeting. 
Integration to Outlook automatically displays the information for 
the type of teleconference you selected in the WebEx Settings 
dialog box when scheduling the meeting.

If you selected the Other teleconference option, this variable 
displays the information that you provided.

<Meeting Link> the Web address, or URL, that attendees can click to join the 
meeting.

<Recording Disclaimer> a statement that reads: This meeting service includes a feature 
that allows audio and any documents and other materials 
exchanged or viewed during the session to be recorded. By 
joining this session, you automatically consent to such 
recordings. If you do not consent to the recording, do not join the 
meeting.

<PKI Information> Public Key Infrastructure measures, such as digital certificates, 
which attendees are required to obtain to prevent any meeting 
data from being disclosed on the server.

Variable Displays ...
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To reset the meeting invitation template to its default state:

1 In Microsoft Outlook, on the toolbar, click WebEx, and then choose Invitation 
Template.

The Invitation Template window appears.

2 Click Reset.
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Editing and Canceling 
Scheduled Meetings

Editing a scheduled meeting
Once you schedule a meeting using WebEx Integration to Outlook, you can use 
Outlook to edit it at any time. For example, you can change its starting time, specify 
a new password, choose a teleconferencing option, and so on. 

Once you edit a scheduled meeting, Integration to Outlook sends an updated 
meeting invitation to any attendees whom you invited to the meeting and also 
updates the meeting information on your WebEx service Web site.

To edit a scheduled meeting:

1 On your Microsoft Outlook calendar, open the item for the scheduled meeting. 

2 Edit meeting information or change options on either the toolbar or on the 
Appointment tab. 

For example:

■ To change the WebEx meeting settings, click Change Settings.

■ To remove the WebEx meeting settings previously set, click Cancel WebEx 
Meeting.

■ To add or change a recurrence pattern, click Recurrence.

If you want to... See...

edit a scheduled meeting Editing a scheduled meeting on page 33

cancel a scheduled meeting Canceling a meeting on page 34
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■ To edit the text in the meeting invitation email message, do it on the 
Appointment tab.

3 Do one of the following, as appropriate:

■ To send the updated meeting invitation to invited attendees and save the 
updated meeting in your Outlook calendar, click Send Update.

■ To save the updated meeting to your Outlook calendar, click Save and Close.

Integration to Outlook contacts your WebEx service Web site and updates the 
meeting on the site. 

Important

■ If you edit a WebEx meeting using your WebEx service Web site, your changes 
will not show in Microsoft Outlook. For example, if you change the meeting’s 
starting time using your site, the starting time does not change on your Outlook 
calendar. Therefore, WebEx recommends that you use only Outlook to edit a 
meeting.

■ If you reschedule or cancel a single occurrence of a recurring WebEx meeting 
using Microsoft Outlook, the changes will show only in Outlook, not on your 
WebEx service Web site. For example, if you change the starting time of a single 
occurrence of a recurring WebEx meeting in Outlook, attendees can still join the 
meeting at the old starting time. Therefore, if you want to modify a recurring 
meeting using Outlook, WebEx recommends that you apply the changes to the 
entire series of the meeting. 

Canceling a meeting
You can cancel a meeting in Microsoft Outlook. When canceling a meeting, you can 
also send a cancellation notice to all attendees whom you invited to the meeting. 

WebEx Integration to Outlook also contacts your WebEx service Web site and 
cancels, or removes, the meeting from your site. A message appears, confirming 
that your meeting was removed.

To cancel a scheduled meeting:

1 In Microsoft Outlook, do any of the following:

■ Open the meeting item. On the toolbar, click .

■ Open the meeting item. On the File menu, choose Delete.

■ Select the meeting item in the calendar. Right-click, and then choose Delete.

2 Choose whether to notify invited attendees or not, and then click OK.
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3 Click OK in the confirmation box.
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Starting a Meeting

About starting a meeting
After you schedule a meeting using WebEx Integration to Outlook, you can start the 
meeting from your Microsoft Outlook or your WebEx service Web site.

Starting a meeting from Microsoft Outlook
In your Microsoft Outlook calendar, open the meeting item, and then click the link 
to start the meeting.

The following figure shows an example of a meeting item.

If you want to... See...

get an overview of starting a meeting About starting a meeting on page 37

start your scheduled meeting from Outlook Starting a meeting from Microsoft Outlook on 
page 37

start your scheduled meeting from your 
WebEx service Web site

Starting a meeting from your WebEx service 
site on page 38
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Important The link that appears in your meeting item is for meeting hosts only. The 
link that appears in attendees’ invitations is a different link, which attendees can 
click to join the meeting. For more information, see Joining a meeting from the 
invitation email.

Starting a meeting from your WebEx service site
Log in to your WebEx service Web site, and then start the meeting from the My 
WebEx Meetings page in the My WebEx area on your WebEx service site.

For more information about starting a scheduled meeting on your WebEx service 
Web site, refer to the documentation on your site.

Click this link to start your meeting.
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Joining a Meeting

About joining a meeting
If you use WebEx Integration to Outlook to schedue a meeting and invite attendees 
to the meeting, they receive an invitation email message that includes a link that 
they can click to join the meeting. 

Meeting attendees can also join a meeting from your WebEx service Web site.

Joining a meeting from the invitation email
In attendees’ email programs, they open the invitation email message that they 
received, and then click the appropriate link in the message to join the meeting. 

The invitation email message or registration confirmation email message that 
attendees receive contain the necessary information they need to join the meeting, 
such as the meeting number, meeting password, or registration ID.

If you want to... See...

get an overview of joining a meeting About joining a meeting on page 39

join a meeting from the invitation email 
message

Joining a meeting from the invitation email on 
page 39

join a meeting from the WebEx service Web 
site

Joining a meeting from the WebEx service 
Web site on page 40
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Joining a meeting from the WebEx service Web site
Attendees can also join a meeting from your WebEx service Web site. 

They may need the following to join a meeting:

■ meeting number—Attendees must provide this to join an unlisted meeting—
that is, a meeting that is not displayed on the calendar on your WebEx service 
Web site.

■ meeting password

■ registration ID—For the Event Center service only. If the event host requires 
attendees to provide registration IDs before they join the event, they receive a 
unique ID in their registration confirmation email message.

Once attendees select the meeting on the WebEx site, they can click Join Now to join 
the meeting.

For more information about joining a meeting on your WebEx service Web site, see 
the documentation on the site.

Click this link to join the meeting.
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